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These notes are specifically for the CSTD Training Course, Introduction to Using 

Outlook, and are best used in conjunction with this course. Some of the information 
can be used and applied, by those who are not on the course, to their PCs on campus 
that also use Microsoft Outlook. 

Note: This document assumes that you are familiar with using a windowing system (with its icons, 
menus and a mouse) and know the procedures of pointing, clicking, double clicking, dragging and 
multi-tasking. 

Introduction 
It is assumed that the course attendee knows how to login to a PC that is in a University PC Facility 
managed by IT Services.  

Please make sure that you login to the PC with your username and password. 

Connecting to the ITS Managed PC Facilities 
Terminal Server 
To have access to Outlook on Exchange, you are going to connect to the ITS Managed PC Facilities 
Terminal Server. To do this:  

1. Click on [Start] in the bottom left-hand corner of the screen followed by All Programs and 

Connect to the IT Services Terminal Server (this should be near the top of the list).  

The screen will change and it will almost look as if you are logging into the PC again, but in fact you 
are now logging into the Terminal Server: 
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2. In the User name: box, type in the Outlook Exchange Class Training username that you have 

been given - it will be of the form vxx040nn, where nn is replaced by numbers  

3. Type in the password for your Outlook Exchange Class Training username and click [OK] or 

press <Enter>  

You should now be successfully logged into the Terminal Server from where you can access Outlook 
under Exchange. 

Opening Outlook 
To open Outlook: 

1. Click on the Outlook icon (it is an orange colour with what looks like a clock inside it) in the 

Quick Launch area or taskbar to the right of [Start] in the bottom left-hand corner of the 

screen (if this is not showing, then click on [Start] followed by All Programs, Microsoft Office 

and finally Microsoft Office Outlook 2007)  

2. Outlook should have already been setup and configured and the opening screen will look 

similar to below: 

 

 

Note: On your own PC, the first time you use Outlook you will probably need to follow the notes to 
Configuring Exchange Access (http://www.reading.ac.uk/internal/its/help/its-help-email/its-
exchange/its-exchange-configure.asp). 

Using the Calendar 
The Calendar is one of the most useful areas within Outlook. You can use it to keep track of both 
work and personal appointments, one-off or recurring appointments, give reminders to yourself of 
important events or dates, and setup meetings with others. 

  

http://www.reading.ac.uk/internal/its/help/its-help-email/its-exchange/its-exchange-configure.asp
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Creating an Appointment 
To get to the Calendar in Outlook, click on the [Calendar] button in the Navigation Pane located in 
the bottom left-hand corner of the Microsoft Outlook window, just underneath the [Mail] button. 
Your screen should look similar to the following: 

 

Let's put in an appointment for a bit later today. There are a few ways to create an appointment, but 
perhaps the easiest/most visual way is as follows: 

1. Depending on the time of this training session, click in the main Calendar grid next to either 
1100 or 1500 to select the time for your appointment - this selected area on the Calendar (a 

half-an-hour slot) should go blue (if you want a longer slot/time, just drag down on the mouse 
to include the next half-an-hour or more)  

2. Right click on the selected blue area and choose New Appointment from the shortcut menu - 
you should get a window similar to the following: 
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3. An Appointment window will open in which you can enter a subject, location and description, 

along with other information. For the Subject, type in Outlook Training Session  

4. Move to the Location box (either use the mouse or press the <Tab> key next to the letter Q on 
the keyboard) and type in the name of your training room, e.g. Sail 107 (after you have 

entered a few appointments in different rooms, you will find that you have a list of rooms to 
choose from)  

5. You should find that the Start time and End time have already been setup according to your 

selection earlier, but you can still change these at this point. Note the All day event box - 
clicking this box means that your appointment becomes an all day event, and the start and 

end time boxes disappear as well as the reminder going to 18 hours before  

6. In the large window/area below the End time box is where you can write a further description 

- put what you like here, or if you can't think of anything, try This is the CSTD course I booked 

onto to learn more about using Outlook!  

7. On the Appointment ribbon at the top of the window, in the Options group, you’ll find some 

useful boxes and icons. The Show As box is very useful as it tells not only you, but also other 
people who might be looking at your Calendar if you are busy or not at this time. The default 

setting is usually Busy. For this training session, click on the down-list arrow and select Out of 

Office  

8. The Reminder box allows you to set whether Outlook should remind you of the appointment. 
This can be very useful, and the default setting is set to remind you 15 minutes before the 

appointment. Click on the down-list arrow to select a different reminder time, or none, if you 
want. The reminder will come up later on your screen (assuming you have Outlook still 

running) as a window similar to below (one option is to snooze it to remind you again later, a 
bit like what you can do with a morning alarm clock!): 

 

9. You can give an appointment a category (at the same time making it more visible in your 

Calendar as it will have a different colour) by clicking on the Categorize icon and then 
choosing one of the categories from the list (you can change the default label settings and 

setup your own ones)  

10. Click on the [Save & Close] icon at the start of the Appointment ribbon - you should find that 

the appointment is now setup in your Calendar in a different colour with a small vertical 

purple/mauve bar on the left-hand side, indicating that you're out of the office at that time  

Note: You can also turn an email message that you receive into an appointment (or meeting) on your 
Calendar by dragging the message onto the [Calendar] button in the Navigation Pane (the 



5 

 

appointment is set to the next available slot on that day, with the subject the same as the subject of 
the email, and the email message filling out the description of the appointment). 

A Recurring Appointment/Event 
This Outlook Training Session is only timetabled for today, but let's say that it was running over 8 
weeks - this is where the appointment/event can be made recurring, i.e. something that takes place 
at regular intervals. 

1. Find in your Calendar the appointment that you've setup for the Outlook Training Session and 
double click on it to open it up  

2. Within the Appointment window, click on the Recurrence icon in the Options group in the 

middle of the Appointment ribbon - you should see a window similar to below: 

    

3. There are a number of options that can be changed, but in this case you only need to change 

when the recurring event ends - click in the radio button (circle) to the left of End after: and 

change the value from 10 to 8 in the box to the right  

4. Click [OK] and then click on the Save & Close icon on the ribbon  

You should find that there is now a   recurrence symbol in the Outlook Training Session 
appointment (bottom right-hand corner). If you now open this recurring appointment, you will see 
the following prompt: 
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You can decide to make a change just to this one occurrence of the appointment, or you can make 
the same change to all the appointments in the series. In this case, [Cancel] as you're not going to 
make any changes. 

Changing the Calendar Layout, View and Other Defaults 

Working with the Date Navigator 

The Date Navigator (the mini-calendar in the top-left of your Outlook window) shows you the current 
month by default, and any numbers in bold indicate that there is an appointment/event on that day 
of the month. You should see this for the recurring appointment that you’ve just setup.  

There are also arrow keys at the top of the Date Navigator (to the left and right of the month) that 
allow you to move forwards to the next month or backwards to the previous month. You can change 
the layout of the Date Navigator so that it appears on the right-hand side of the Outlook window, 
and you can expand it to show just more than the current month as follows (this could be useful if 
you wanted to move or copy an appointment from the current month to a future month): 

1. On the View menu, click To-Do Bar followed by Normal 

This will move the Date Navigator to the right-hand side of the Outlook window, and below it will 
show the next few appointments that you have followed by any tasks that you have setup. You can 
modify the layout in the To-Do Bar further through the View menu by switching the individual 
components on or off (i.e. date navigator, appointments and task list). 

2. To expand the Date Navigator so that you can see more than 1 month, rest the mouse pointer 

on the split bar to the left of the Date Navigator. When the pointer becomes a double-headed 
arrow, drag the pointer to the left so that you can see two columns of little calendars for this 

and next month. It's up to you how many months you want to show, but this is how it would 
look if you've set it up this way: 
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Changing the Calendar View 

At the top of your calendar, just above the dates, you have buttons that can switch the view to a Day, 
Week, or Month. Try these out to see the difference. Return to Day view by clicking on the 
appropriate button. 

Within Day view, the default  time interval for appointment slots is 30 minutes, but you can change 
this by right clicking in the area where the times are shown to the left of the appointment slots, and 
choosing the time interval, say 15 minutes, that you want instead from the shortcut menu. 

Other Calendar Defaults 

To see some of the other Calendar defaults that have been setup: 

1. On the Tools menu, click Options... 

 

 

 

2. In the Preferences tab, under the Calendar section, you'll see the option to change the time of 
the Default reminder or remove it completely 
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3. Click on [Calendar Options...] to get to more choices: 

 

 

 

Here you can: 

 Customize your work week if you work part-time or night shifts (appointments can be 

setup out of normal working hours) - select the check boxes for the desired working days 

and set the appropriate times in the Start time and End time boxes. You can also change 

the First day of week if you don't start work on a Monday  

 Change the default colour of your calendar, usually blue at the start - particularly useful if 

you are looking at more than one calendar and need to distinguish between them  

 A [Add Holidays...] button - the default for your Calendar is to include UK holidays, but if 

you also want to include holidays from another country or religious holidays, then this is 

where you would set this up  

 A [Free/Busy Options…] button where you can change how many months of your calendar 

people can check to see if you’re available for a meeting (they will only see if you’re free or 

busy, but not the details of your appointments). The recommendation is to set this to 12 

months 

 A [Time Zone...] button which would allow you to show you the time as it is in another 

country (show an additional time zone) - this might be useful if your work involved travel 

abroad  

If you want Outlook to go directly into your Calendar on start up: 

1. On the Tools menu, click Options..., and then click the [Other] tab  
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2. Under General, click [Advanced Options...] 

 

 

 

3. Next to Startup in this folder, click Browse  

4. In the Select Folder dialog box, select Calendar, and then click  [OK] three times to accept the 

change and close the open dialog boxes - test this out if you like by exiting from Outlook and 

then going back in again 

As well as setting up Outlook to start in either your Inbox or Calendar, you could also choose 
Contacts, any other mail folder or your Mailbox. This latter option gives comes up with a screen 
giving you the next few days’ appointments, a summary of current tasks, and the number of unread 
messages in your inbox. 

Organising a Meeting 
This is probably one of the areas that most people are interested in when they hear about Outlook. 
Organising a meeting is not that difficult to do, but finding out the dates/times when other people 
are available is more difficult and not always possible. Let's see how one would go about organising a 
meeting (it's really a special type of appointment) - firstly, you need to start with a possible meeting 
time/date and choose your attendees: 

1. Click in the main Calendar grid to select the time for your meeting, say later today or 

tomorrow (you need to have the Calendar in Week view) - this area should turn blue  
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2. Click on the Actions menu and choose Plan a Meeting 

 

 

3. You are the only attendee at present (as you are the organiser!). To invite other attendees, click 

on [Add Others] and choose Add from Address Book...  

In the Select Attendees and Resources window that appears, a list of names from the Global Address 
List is shown. The Global Address List contains a list of all the users and groups that have accounts 
on the Exchange server. The majority of University staff have now been moved to Microsoft Outlook 
on Exchange.  

4. Click on the drop-down list-arrow next to Global Address List and choose the last option in the 

list of Training Address Book  

5. A list of the Outlook Exchange Class Training usernames (vxx040nn) will appear in the main 

part of the window - select the one that your neighbour is using and click on the [Required] 
button just below Message Recipients  

6. Let's also invite someone else as an optional attendee to the meeting - select another 

username from the Training Address Book  

7. Click on the [Optional] button just below [Required] 

 
8. Click [OK]  

You are returned to the Plan a Meeting window, and should now be able to check if your attendees 
are free to come to your meeting. Hopefully, you will be able to see this free/busy time information 
for yourself and for your neighbour on today's training session. 

Note: If you see 'slashes' across the schedule for a particular attendee, this indicates that there is no 
free/busy time information available for that attendee. This could be because the attendee does not 
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use Microsoft Outlook on Exchange, or that they haven't yet used the Calendar to make any 
appointments. 

If the currently selected time for the meeting is no good as one of your attendees is busy or out of 
the office at that time, then click on [AutoPick Next>>] to find the next available free time (you can 
also move the time slot with the mouse or change the meeting start and end times). 

The final steps are to fill in more details about the meeting and then send off invites: 

9. Click on [Make Meeting]  

10. A Meeting window is shown (similar to an Appointment window) - fill in the details for subject 

(e.g. Paul's Test Meeting, but put your own name so you can recognise your own meeting!), 
location and description, a bit like below: 

 

 

 

11. Click on [Send]  

12. You are taken back to the Plan a Meeting window - this time click [Close] 

You should find that a Test Meeting entry has been put into your Calendar. 

You will now have to wait to see if your attendees accept or decline the invitation to your meeting! 
You can keep a track on this by: 

1. Opening up the Meeting item on your Calendar 

2. Click on the Tracking icon in the Show group on the Meeting ribbon - here you can see if any 
of your attendees have responded yet 

3. Close the Meeting window 

As well as inviting people to your meeting, you should also find that you have been invited by email 
to another meeting by your Outlook Training neighbour! 

1. To look at your email, click on the [Mail] button in the Navigation Pane (usually in the bottom 

left-hand corner of the Outlook window) 
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2. Click on the message about the meeting - it should look a bit like below: 

 

 

 

You have the following choices: 

 Accept a meeting that you know you'll be able to attend. When you accept a meeting, the 

meeting is scheduled in your Calendar and you receive updates if the meeting organiser 

changes the details of the meeting. If others view your free/busy time, the time appears as 

Busy by default 

 Decline a meeting if you can't go. Declining a meeting deletes the item from your Calendar 

(freeing that block of time), but it does not cut your ties with the meeting: You'll still get 

updates if the meeting organizer makes them and you'll have the opportunity to respond 

to the update. (If you truly want to opt out of a meeting, you may want to ask the 

organizer to remove your name from the attendee list) 

 Tentative - use this option if you're interested in the meeting, but aren't sure whether 

you'll be able to make it. The meeting is scheduled in your Calendar and that block of time 

is displayed to others as tentatively unavailable 

 Propose New Time - when you choose this and propose a new time, the meeting organiser 

receives your request... but as with all things about the meeting, the organiser gets to 

make the final decision about the new meeting time 

 Calendar – to check your calendar in a new window 

3. Click on Accept 

 
 

4. Go with the default of Send the response now by clicking [OK] 

If you wanted to Edit the response before sending, e.g. to say that you'll be late for the meeting, then 
choose that option. The last option is not one that you should usually choose (as you won't get any 
updates about a possible changed meeting time). 

5. Go back to your Calendar by clicking on the [Calendar] button in the Navigation Pane - you 

should find an entry for the meeting from your neighbour has been added 
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Using the Email System 
Most, if not all, of you should already be familiar with using email. The next sections will show a few 
things that you might not already know or that are specific to email in Outlook. 

Adding a Signature 
An automatic signature can be set up so that when you send a message, contact information about 
you is automatically put at the bottom of your message without you having to type it every time. It 
is often useful to include your name, email address and contact phone numbers. Try setting up your 
own signature as follows: 

1. Open the Tools menu and choose Options...  

2. Click on the [Mail Format] tab at the top of the Options window  

3. Click the [Signatures...] button towards the bottom of the window 

4. In the Signatures and Stationery window that appears, click on [New]. Enter a name for your 

signature, e.g. work, and click [OK] (you could have one signature for work messages and a 

different one for personal messages)  

5. Type in the information that you want in your signature - try and keep it plain and simple for 

now (there are formatting options to use different fonts, put on bold etc). An example of how 
a signature might look is given below:  

 

6. Create a second signature for personal use, repeating steps 4 and 5 above 

7. Setup work as the default signature for new messages by clicking on the appropriate 

dropdown list arrow and then click on [OK]. Click on [OK] again back at the Options window 

8. The Calendar will probably still be showing from what was being done earlier - to get to the 

Mail in Outlook, click on the [Mail] button in the Navigation Pane, just above the [Calendar] 
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button. You will be looking at your Inbox - there may already be a message of an acceptance to 

your meeting by one of the attendees 

9. Click on the [New] button (towards the top left-hand corner of your Inbox window) to send a 

message - you should now see your work signature at the end of your message 

Tip: If you want to change the signature in your message to a different one, e.g. your personal 
signature, just right click on the signature and choose the other signature from the menu. 

10. In the text box to the right of the [To...] button, type the letter v - you should find that it has 

remembered the email addresses beginning with v that you have used before when setting up 

a meeting. This is because AutoComplete suggestion has been turned on in Outlook. Select, 

using the mouse, one of the listed email addresses (which should hopefully be someone else 
on the class)  

Note: AutoComplete suggestion is very useful, but sometimes it can be annoying as it may come up 
with email addresses that you may have only used once or no longer work. You can delete such an 
email address when the AutoComplete suggestion brings it up in the list (literally use the <up> or 
<down> arrow keys to select the address and press the <Delete> key on the keyboard). There is also 
an option to turn AutoComplete suggestion off completely via Tools, Options..., [E-mail Options] and 
[Advanced E-mail Options...] – turn off the Suggest names while completing To, Cc, and Bcc fields check 
box. 

Another option in the same area, i.e. Tools, Options..., [E-mail Options] and [Advanced E-mail 
Options...], that says Allow comma as address separator should be turned on to allow for cases where 
email addresses are being copied from another system to Outlook, e.g. the RISIS system, specifically 
where a tutor wants to send emails to students on a particular RISIS module. 

 

11. Send a carbon copy of the new message to the Training username that you're using by 

clicking on the [Cc...] button - note that the default setting (i.e. how Outlook is setup when you 

first use it) is that a copy of every message you send is saved in a Sent Items folder (you can 
turn this off if you want via Tools, Options... and [E-mail Options])  
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In the Select Names window that appears, a list of names from the Global Address List is shown. 

12. Click on the drop-down list-arrow next to Global Address List and choose the last option in the 

list of Training Address Book  

13. A list of the Outlook Exchange Class Training usernames (vxx040nn) will appear in the main 

part of the window - select your Training username and then click on the [Cc] button just 

below Message Recipients  

14. Click on the drop-down list-arrow next to Training Address Book and choose Global Address List 
(near to the top of the list). You are going to try and find your Reading email address 

15. Click on the Advanced Find link to the right of the drop-down list. A Find window should 
appear as below: 

 

16. Put in your lastname and, if necessary to distinguish yourself further, your firstname and/or 

department. Click [Ok]. Back at the Select Names window, hopefully you should be able to 
find your full name in the list (you may need to scroll down)  

17. Click on your name in the list and then the [Bcc] button -  your name (underlined), which 

represents your Reading email address, should have been copied into the text box next to 

[Bcc] (if your name is not found in the Global Address List then click in the text box next to 

[Bcc] and type in your full Reading email address)  

Note: Bcc stands for Blind Carbon Copy, and means that other people who receive the message will 
not know that it has also been sent to the blind carbon copy email address, in this case yours. This 
can be useful in the case where you want someone to get this message, but not allow the other 
receivers to know who this someone is. It can also be used when you’re sending a message to a large 
number of people, but be aware that this is not normally recommended practice as it is a technique 
often used by spam mailers (it’s better to setup or use a mail list with a specific email address). 

18. Type in a subject for your message, then write a short welcome to your class colleague in the 

main message window and click on [Send]. you should receive a copy of this message in your 
Inbox as you Cc'd it to yourself  

 Note: You may find that when you first use your Exchange account, no emails seem to be arriving 
there. If this is the case then see the section under Email in the Microsoft Exchange FAQ 
(http://www.reading.ac.uk/internal/its/help/its-help-email/its-exchange/exchangefaq.aspx). 

  

http://www.reading.ac.uk/internal/its/help/its-help-email/its-exchange/exchangefaq.asp


16 

 

Tips on Using your Mailbox 
Here are some tips that you may find useful. 

The Reading Pane and AutoPreview 

You will probably find that you can already see the content of one of your messages (the currently 
selected one) in your Inbox towards the right of your screen (just to the left of the To-Do bar if you 
have this showing). This is because the Reading Pane is on by default. This is good for security as you 
can view messages safely in the Reading Pane. Potentially malicious scripts or attachments are not 
activated or opened automatically in the Reading Pane. If you want to change the settings for the 
Reading Pane: 

1. Open up the View menu  

2. Choose Reading Pane  

3. Select Right, Bottom or Off  

From the above, you can see that you can have the Reading Pane below or to the right of your 
messages in the Inbox, or turn off the Reading Pane completely (in this case, you would need to 
double click on a message in the list to open it in its' own window). 

A further refinement is to have AutoPreview turned on. This allows you to preview the first three 
lines of messages in your Inbox, and so gives you some idea of what the message contains before you 
look at it in more detail. To do this, go to the View menu and click AutoPreview.  

This will apply to all the messages in your Inbox - if you just want it to be shown for only new 
messages, then a few more steps have to be carried out: 

1. On the View menu, point to Current View, and then click Customize Current View  

2. Click Other Settings and a window similar to below should appear: 

 

3. Under the AutoPreview section, click Preview unread items  

4. Click [OK] 2 times  
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At the top of your screen, just below the menus, you should have both the Standard and Advanced 
toolbars showing. On the second Advanced toolbar, you should see buttons to turn on or off both the 

Reading Pane (   ) and AutoPreview (   ). 

Arrange by Conversation 

If you receive many e-mail messages daily, you could benefit from a grouping option called Arrange 
By Conversation. Arrange By Conversation view shows your message list in a conversation-oriented 
or "threaded" view. Each conversation can be expanded further to show all messages in the 
conversation, including messages you have already read. 

To be able to see the above in action, you will need to reply to the message that your neighbour just 
sent you: 

1. Select the message (not the meeting invitation) that your neighbour sent  

2. Click on the [Reply to All] button on the Standard (top) toolbar - this will mean that both your 

neighbour and yourself will get this reply (if this isn't the case then put on the other 

username by hand)  

3. Write your reply and [Send] it  

Your reply should now appear in your Inbox. By default, the messages are arranged by date with the 
newest on top. To arrange by conversation, just click on the View menu followed by Arrange By, and 
finally Conversation. You should now see a small icon looking like a down-arrow in a box to the left 
of one of the messages in your Inbox:  

 

 

If you click on this down-arrow, you should now see both the original message in the conversation 
and the reply underneath it. 

Colour Coding Messages 

One way of identifying particular messages in your Inbox is to use colour coding (other ways are to 
use folders for different messages if you have problems distinguishing colours or to setup rules and 
alerts). For example, you could use a colour to identify messages from a particular person such as 
your class neighbour: 

1. Select a message in the Inbox from your neighbour  

2. Open up the Tools menu and choose Organize  
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3. A Ways to Organize Inbox window will appear above your Inbox. On the left-hand side of this 

window, click on Using Colors: 

 

 

 

4. Choose the colour that you want your neighbour's message to be shown in by clicking on the 

dropdown list arrow next to Red and picking the colour you want. Click on [Apply Color]  

5. To close the Ways to Organize Inbox window, click on the X next to Automatic Formatting...  

The changes you have made should now be reflected in your Inbox list. Note that you can setup 
more advanced rules for your emails through Tools, Rules and Alerts... – for some examples of how to 
do this, see the Outlook Rules (http://www.reading.ac.uk/internal/its/help/its-help-email/outlookrules.aspx) 
web page. These can be used to sort, redirect or delete emails as they come in, amongst other actions. 

Favourite Folders 

Here you can keep the folders that you use most often so that it's much easier to find them and save 
messages into them. Let's create a new folder, save one of our messages in it, and then add that 
folder to the Favorite Folders: 

1. To create a new folder, click on File, Folder, New Folder...  

2. Type in a name for your new folder, e.g. Test Messages  

3. Make sure you click on Mailbox - your_username at the top of the list of where to save the 
folder  

4. Click [OK]  

You should now see the new folder under Mail Folders (just under Favorite Folders on the left-hand 
side). To move this new folder into the Favorite Folders section, right click on your new folder and 
select Add to Favorite Folders (an alternative is to drag the new folder): 

 

http://www.reading.ac.uk/internal/its/help/its-help-email/outlookrules.asp
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You should now find that a copy of the new folder is in the Favorite Folders section. Save one of your 
messages into the new folder (just drag it across). 

For Follow Up Folder 

The folder named For Follow Up always contains an up-to-date list of all Quick Flagged messages in 
every folder in your mailbox. So you can use it to flag messages that you know need following up - in 
this way it can be used as a to-do list. To see how you can use this: 

1. Looking at the list of messages in your Inbox, you should notice a faded flag to the right of 

each. Click on this flag next to one of the messages (not your meeting invitation) - you should 

find that it goes red  

2. If you look at your To-Do Bar on the right of your screen (View, To-Do Bar, Normal to show it 

again), you should notice the new flagged message as a task at the bottom: 

 

3. By right-clicking on the red flag next to the message, more options are available with different 

coloured flags standing for things like Tomorrow, Next Week, Custom… etc. Another option is 

Add Reminder... under which you can give a date and time for the reminder to be set. Click on 

this to get a dialogue box like below:  

4. Change some of the details like the Due date and/or Reminder if you want and then click [OK]  
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The For Follow Up folder is a special type of folder called a Search Folder, but it isn’t yet showing. To 
enable it to show: 

5. Your Search Folders appear under Mail Folders on the left-hand side of your window. You may 

need to scroll down to see them and click on the + next to Search Folders.  

Other Search Folders that may have been setup are Unread Mail, Categorized Mail and Large Mail.  If 
you receive any attachments then you will find that another Search Folder called With Attachments 
is created. 

6. Right click on Search Folders and choose New Search Folder...  

From here you can choose from a list of pre-defined templates or create a search with custom 
criteria and save it as a Search Folder for future use. 

7. To setup a For Follow Up folder, click on Mail flagged for follow up and then [OK]: 

 

A For Follow Up folder should now be showing under Search Folders, and will contain a copy of the 
flagged message. This can be added to Favorite Folders if you like. 

Blocked Attachments 
You will find that in Outlook there are certain files that will be automatically blocked if they have 
been sent as attachments. These include executable programs with an extension of .exe, Active 
Server Pages with an extension of .asp, and, perhaps more surprisingly, Microsoft Access related files 
including database files with an extension of .mdb 

If you receive a blocked attachment, you'll need to contact the sender and ask that person to resend 
the file using one of the following methods: 

 Zip it into a zip-compressed file - you will need to have something to unzip it on arrival  

 Link to it - if you share a file server with the recipient, you can put the file there and send a 

link to the file rather than sending the file itself.  

 Rename it - you can rename the file and use a filename extension that Outlook won't 

block, such as .txt. When you do this, you may need to include some instructions in your 

message on how to open the file. 

For further details, open up the Outlook online help and search for blocked attachments. 
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Away from the Office 
If you’re going to be away from the office, you should consider setting up a vacation/holiday 
message. This can be done as follows: 

1. Click Tools, then select Out of Office Assistant  - a dialogue box  similar to below appears: 

 

2. Ensure that I am currently Out of the Office is selected 

3. Write your message in the first box under AutoReply 

4. If you want to setup any rules for while you’re away, e.g. move particular emails to a specific 

folder, then use [Add Rule…] 

5. Click [OK] 

When you next run Outlook on your return, it will come up with a warning in the bottom right-
hand corner of your Outlook window saying that Out of Office auto-replies are on. Click where it is 
pointing and choose Turn off Out of Office auto-replies to show that you are back in the office. 

Whilst you’re away, you can use OWAmail (Outlook Web Access) to access your email at the 
University of Reading on any computer that has access to the internet. See the OWAmail Quick 
Guide (http://www.reading.ac.uk/web/files/www_File_Library/owamail.pdf) for further details. 

If you wanted to allow somebody else to use your own Inbox whilst you're away, then look at the 
section under Allowing access to your Inbox on the Exchange Mailbox Tasks web page 
(http://www.reading.ac.uk/internal/its/help/its-help-email/its-exchange/its-exchange-
mailboxtasks.aspx). 

Using Contacts 
This training course has mostly concentrated on using the Calendar and Email in Microsoft Outlook, 
but now let's take a brief look at Contacts (for further information on importing address books and 
looking at the differences between contacts and address books, look at the online help within 
Outlook). 

The sections below come from our Exchange Contacts web page 
(http://www.reading.ac.uk/internal/its/help/its-help-email/its-exchange/its-exchange-contacts.aspx) 
which also tells you about the Global Address List, your address book, and setting up a distribution 
list. 

http://www.reading.ac.uk/web/files/www_File_Library/owamail.pdf
http://www.reading.ac.uk/web/files/www_File_Library/owamail.pdf
http://www.reading.ac.uk/internal/its/help/its-help-email/its-exchange/its-exchange-mailboxtasks.aspx
http://www.reading.ac.uk/internal/its/help/its-help-email/its-exchange/its-exchange-contacts.asp
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Adding a New Contact 
1. Click on the [Contacts] button in the Navigation Pane  

2. At present, there will be no contacts - to create a new contact just double click where it says to 

create a new contact (or click on the New button - the first button on the toolbar) 

 

3. Enter in the information as required, either for yourself, a colleague or a friend:  

 You should enter a name in the box marked Full Name. If you click on the [Full Name] 

button then you can enter information regarding the user’s title, first name, last name etc.  

 Under File as: you can choose to store your contacts in either alphabetical order of the 

surname or the first name  

 There are three different email addresses that you can add, and these are displayed by 

clicking on the down arrow by the E-mail... box. You should enter at least one email 

address.  

 You can enter as much other information as you wish. Under Details in the Show group on 

the ribbon, you can store ‘important’ dates such as the contact’s birthday and wedding 

anniversary! 

4. When you have finished adding information, remember to click [Save & Close], the first icon 
on the ribbon 

Current View of Contacts 
This is currently set to Business Cards as shown below: 

 

You can set this to a different view if you prefer, e.g. Address Cards. 
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Adding an Address from an Email 
You can add someone to your Contacts if they have sent you an email as follows: 

1. Click on the [Mail] button in the Navigation Pane and select one of the emails you received 

earlier  

2. Inside the message window/pane, select the address that you want to add (e.g. your 

neighbour's training username), and right click on it  

3. Select Add to Outlook Contacts... from the shortcut menu  

4. The contact box should open, and you can add as much information as before (note that the 

full name and email address have already been added)  

5. When you have finished adding information, remember to click [Save & Close] 

Sending an Email to a Contact 
To send an email to someone in your Contacts (assuming you're still looking at your email 
messages): 

1. Click the [New] button on the top, standard toolbar  

2. Click on the [To...] button next to where you would normally type the email address of the 
person you are sending the email to  

3. Click on the drop-down list-arrow under Address Book and currently showing Global Address 

List, and scroll up the list to choose Contacts  

4. Choose one of the names you have put into your Contacts and click on the [To] button at the 

bottom of the Select Names window  

5. Click [OK], type in your subject and message and then send it to your contact 

Setting up a Task 
You might have noticed earlier that a to-do list could be setup using a For Follow Up folder. Another 
way of setting up tasks is as follows: 

1. Click on the [Tasks] button in the Navigation Pane 

2. As a message was flagged earlier, it’s probably showing the Current View as a To-Do List – 

change this to Simple List so the screen looks similar to below: 

 

 
3. Click where it says Click here to add a new Task  
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4. Type in something like Look at further things to do in Outlook and press <Enter> - you should 

find that this has now been setup as a new task  

To add further details to the task, double click on it to open it up - you can then specify details such 
as the due date, the current status (e.g. not started, in progress etc.) and how much of it has been 
completed in percentage terms.  

Further Information 
Here are some ways to get further information or help: 

 Microsoft Outlook has its own built-in Help system, which contains a considerable amount of 

information as well as tips and examples. It can be accessed in the usual ways:   

 Opening the Help menu 

 Pressing key <F1> 

 Clicking on the question mark icon at the end of the top Standard toolbar 

 Putting in your own query in the text box where it says Type a question for help  

 A more advanced course, Outlook 2007 Hints & Tips 

(http://www.reading.ac.uk/web/files/its/Outlook2007Tips.pdf ) has been developed which has 

sections on:  

 Organising email  

 Printing emails 

 Sending emails 

 Sharing information 

 Calendar 

 Further documents on using Microsoft Outlook at the University are available from the IT 

Services Staff Email Documentation web page (http://www.reading.ac.uk/internal/its/help/its-

help-email/its-exchange/its-staff-email.aspx)  

 Microsoft's own website has some very useful online training courses on Outlook 2007 

(http://office.microsoft.com/en-gb/training/HA102188671033.aspx) 

Logging Out 
You have now finished this training session, so shut down any open windows and log out:  

1. Close Outlook by clicking on its [Close] button  

2. To logout from the Terminal Server, click on [start], choose Log Off and press <Return> for 

[Log Off] to confirm this  

3. Finally, on IT Services machines, to logout from your personal username, click on [start], 

choose Log Off, and press <Return> for [Log Off] to confirm this  
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http://www.reading.ac.uk/nmsruntime/saveasdialog.aspx?lID=40681&sID=177128
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